MICROSOFT EXCEL BASICS AT THE
DEERFIELD PuUBLIC LIBRARY

DEERFIELD

PUBLIC LIBRARY
CLAss OUTLINE: EXPECTED OUTCOMES:
1) What is Microsoft Excel? 1) Familiarity with the functions of Excel
2) Features of the Ribbon 2) Ability to customize and save your work

3) Processing and Saving your work

4) Questions, Answers and Review

WHAT IS MICROSOFT EXCEL?

Microsoft Excel is a spreadsheet is the computer equivalent of a paper ledger sheet. It consists of a grid
made from columns and rows. It is an environment that can make number manipulation easy and somewhat

painless.

It is part of the Microsoft Office Suite.



UNDERSTANDING WHAT YOU SEE ON THE HOME TAB
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Ribbon and Tabs: The Ribbon/Tab presentation style is pretty standard across all of your Microsoft Office
Suite programs. Microsoft Word has tried to streamline the appearance of its options by hiding away extra
menus. This is called back staging and occurs inside each Tab. There are a few popular buttons up front on
the Ribbon to help with certain tasks, but there are many more options behind the scenes. You can get to
the extra options by clicking the grey arrows in the lower right hand corner of each grouping.

Multiple Sheets: Spreadsheets can use multiple sheets, and you can move from one sheet to another. There
are even functions that are built into Excel (under the Formulas tab) that will make your sheets automatically
coordinate.

Row vs. Column: Rows are the lines that move HORIZONTALLY across the paper and have a number at the
beginning. COLUMNS are the divisions that run VERTICALLY across the paper and have a letter at the top.
When you are identifying a cell, it will be done with the Letter:Number (Column:Row).

Formula Bar: The long bar across the top is a place for you to see how your text will appear as you are
entering it. The text can also be entered directly into the cell, but it is a bit easier to edit the text in the larger
line. The box to the left of this viewer is called the Identifier box and gives you “the cell’s address.”



How Tos:

CELL CONTENT

Each cell can contain its own text, formatting, comments, formulas, and functions.

Text: Cells can contain letters, numbers, and dates.

Formatting attributes: Cells can contain formatting attributes that change the way letters, numbers, and
dates are displayed. For example, dates can be formatted as MM/DD/YYYY or Month/D/YYYY.

Comments: Cells can contain comments from multiple reviewers.

Formulas and Functions: Cells can contain formulas and functions that calculate cell values. For
example, SUM(cell 1, cell 2...) is a formula that can add the values in multiple cells.

To INSERT CONTENT:

1. Click on a cell to select it.

2. Enter content into the selected cell using your keyboard. The content appears in the cell and in the
formula bar. You also can enter or edit cell content from the formula bar.
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To DELETE CONTENT WITHIN CELLS:

Select the cells which contain content you want to delete.
Click the Clear command on the ribbon. A dialog box will appear.
Select Clear Contents.

You can also use your keyboard's Backspace key to delete
content from a single cell or Delete key to delete content from
multiple cells.
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DeELETE CELLS:

1. Select the cells that you want to delete.
2. Choose the Delete command from the ribbon.

3. There is an important difference between deleting the content of a cell and deleting the cell itself. If you
delete the cell, by default the cells underneath it will shift up and replace the deleted cell.
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Cut, CoPY AND PASTE:

1. Select the cells you want to format.

2. Right-click on the selected cells. A dialog box will appear where you can easily access many commands
that are on the ribbon. The area of cells you selected will have a blinking border.
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To DRAG AND DROP CELLS: A | =B c D E
1 |51,799.00
1. Select the cells that you wish to move. 2 SZDD 00
2. Position your mouse on one of the outside edges of 3
the selected cells. The mouse changes from a white 4
cross to a black four pointed arrow. 2
3. Click and drag the cells to the new location.
4. Release your mouse and the cells will be dropped . B o e
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To UseE THE FiLL HANDLE TO FiLL CELLS:

1. Select the cell or cells containing the content you

want to use. You can fill cell content either vertically
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or horizontally. 1 Office Christmas Party
- X 2
2. Position your mouse over the fill handle so that the 3 |Employee Attending Not Attending
white cross becomes a black cross. 4
. . . 5 |P . Bri X
3. Click and drag the fill handle until all the cells you erazs r'a_n
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Olvera, Emily K.
10 |Wodal, Matthew
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12 Dees, Robert
12 'Wimblet, Grace
14 Salter, Joe Ann

4. Release the mouse and your cells will be filled.
(This is a great tool when you’re doing a multi-add!)
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MODIFYING COLUMNS, Rows AND CELLS

When you open a new, blank workbook, the cells are set to a default size. You do have the ability to modify
cells, and to insert and delete columns, rows, and cells, as needed. In this lesson, you will learn how to
change row height and column width; insert and delete rows and columns; wrap text in a cell; and merge

cells.

1. Position your mouse over the column line in the column heading so that the white cross becomes a

double arrow .

2. Drag your double arrow in the direction that you want to stretch or shorten the cells. The process will

modify the entire row or column, but not ALL of them.

To SET COLUMN WIDTH WITH A SPECIFIC MEASUREMENT:

Select Column Width.

A

**Select AutoFit Column Width from the format drop-down menu and Excel will automatically adjust each

Select the columns you want to modify.

Click the Format command on the Home tab. The format drop-down menu appears.

The Column Width dialog box appears. Enter a specific measurement (this is measured in pixels).

Click OK. The width of each selected column will be changed in your worksheet.

selected column so that all the text will fit.**
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You can do the same process with your ROWS, too. They will just

be called ROW width instead!



TO INSERT A ROwW OR A COLUMN:
1. Select the row BELOW where you would like the new row/column to appear.

2. Hover over the header for your column or row.

3. Right Click to bring up your menu.

4. Select Insert, and the new row will appear above the one you selected.

AT - Jf | McBride, Rebecca
| A B C

1 Ashberry, Jane 919-382-6561 ashberryji@hpasnc.org
2 Davis, Garrett 919-576-4562 davisg@hpasnc.org

3 Eberhardt, Elizabeth 252-985-3558 eberhardte @hpasnc.org
4 Everett, Carol 919-503-9560 everettci@hpasnc.org
5 |Hepburn, Katie H. 704-882-5559 hepburnk@hpasnc.org
6 Lovelace, Deb 919-785-9656 Iuvelaced@hpaﬁnc.urg
=y LMcBride, Rebecca B828-357-0072 mcbrider@hpasnc.nrg
& Mixon, Daniel 919-821-7425 mixond@hpasnc.org

9 Stevens, Kevin 919-783-8564 stevensk@hpasnc.org

A7 - S
fi B C

1 Ashberry, Jane 919-882-6561 ashberryji@hpasnc.org
2 Davis, Garrett 919-576-4562 davisg@hpasnc.org

3 Eberhardt, Elizabeth 252-985-3558 eberhardte @hpasnc.org
4 Ewverett, Carol 919-503-3560 everettci@hpasnc.org
5 |Hepburn, Katie H. 704-882-5559 hepburnk@hpasnc.org
6 Lovelace, Deb 919-735-9656 Iuvelaced@hpaﬁnc.urg
7|,

8 «¥Bride, Rebecca 828-357-0072 mchrider@hpasnc.org
9 Mixon, Daniel 0919-821-7425 mixond@hpasnc.org
10 |Stevens, Kevin 919-7533-3504 stevenski@hpasnc.org

The Paintbrush that appears will allow you to edit the formatting of the row you’ve just inserted. By default,

it will have the formatting of the other rows.

**You follow the same process for adding a column, but the new column will appear to the LEFT of what

you’ve selected.**

Deleting Rows or Columns is similar!

1. Select the row/column you want deleted by clicking on the header.

2. Right click to bring up your menu and select Delete.

3. The information for the whole row will disappear.




WRAP TEXT AND MERGE CELLS:

If a cell contains more text than can be displayed, you can choose to wrap the text within the cell or merge
the cell with empty, adjoining cells. Wrap text to make it display on multiple lines of the cell. Merge cells to
combine adjoining cells into one larger cell.

1. 1. Select the cells you want to wrap.

Bl - Jfe | 78-A Meadowview Lane Raleigh, NC 27589
. B C D E
Ashberry, lane 78-A Meadowview Lane Haleigh, NC 27589
Davis, Garrett 29 North Luke Court Raleifzh, NC 27576
Eberhardt, Elizabeth 63-C Chapel Court Louisberg, MC 27079
Everett, Carol 123 Garden Plow Way Chipel Hill, NC 27051
Hepburn, Katie H. 127 South Pejulup Lane Cary, MC 27057
Lovelace, Deb 124 Heuristic Way Newbegln, NC 24434
Manning, Christopher L. 2380 New Cove Road Ralgligh, MC 27587
McBride, Rebecca 131 W Clinton Street Cang NC 27054
Mixon, Daniel 9 Atlantic Boulevard Ralejgh, NC 27086
Stevens, Kevin 2520 Hopkins Road Durhafm, NC 27054
2. Select Wrap Text on the Home Tab.
3. The text in your selected is now wrapped.
Bl - S| 78-A Meadowview Lane R
i B C
Ashberry, Jane 78-A Meadowview Lane
Raleigh, NC 27589
Davis, Garrett 29 North Luke Court
Raleigh, NC 27576
Eberhardt, Elizabeth 63-C Chapel Court
Louisberg, NC 27079
Everett, Carol 123 Garden Plow Way
Chapel Hill, MNC 27051
Hepburn, Katie H. 127 South Pejulup Lane
Cary, NC 27057
Lovelace, Deb 124 Hewuristic Way
Newbern, NC 24434
Manning, Christopher L. 2380 New Cove Road
Raleigh, NC 27587
McBride, Rebecca 131 W Clinton Street
Cary, NC 27054
Mixon, Daniel 9 Atlantic Boulevard
Raleigh, NC 27086
Stevens, Kevin 2520 Hopkins Road
Durham, NC 27054




MERGE YOUR CELLS:

1R x 4C - fx | HPAS North Carolina Board of Directors
A | B | c D |
HPAS Morth Carolina Board of Directors
oo
1 | |
Ashberry, lane 78-A Meadowview Lane 919-882-6561  ashberryj@hpasnc.org
Raleigh, NC 27589
2
Davis, Garrett 29 North Luke Court 919-576-4562 davisg@hpasnc.org
Raleigh, NC 27576
3
Eberhardt, Elizabeth 63-C Chapel Court 252-985-3558 eberhardte@hpasnc.org
Louisberg, NC 27079
4

1. Select the cells you want to Merge together.
2. Select the Merge and Center option on the Home Tab to bring the cells together.

3. In the drop down arrow next to Merge and Center, there are other options than Center. You can change

the alignment here.

SIMPLE FORMULAS:

A formula is an equation that performs a calculation. Like a calculator, Excel can execute formulas that add,
subtract, multiply, and divide. One of the most useful features of Excel is its ability to calculate using a cell
address to represent the value in a cell. This is called using a cell reference. In order to maximize the
capabilities of Excel, it is important to understand how to create simple formulas and use cell references.

Excel uses standard operators for equations, such as a plus sign for addition (+), a minus sign for
subtraction (-), an asterisk for multiplication (*), a forward slash for division (/), and a caret (*) for
exponents.

The key thing to remember when writing formulas for Excel is that all formulas must begin with an equal
sign (=). This is because the cell contains, or is equal to, the formula and its value.

Addition

Subtraction

Multiplication

Division

Exponents




To CREATE A SIMPLE FORMULA
IN EXCEL.:

Select the cell where the answer will appear (B4,
for example).

Type the Equal Sign (=).
Type the formula you want Excel to calculate.

Press enter. The formula will be calculated and
only the value will display inside the cell.

B4 v fe

A B C
1 Estimated painting cost per square foot
2 Total cost 575.00
3 Square Feet 250
4 |Total/SqFt oo I
5

MAX - X « f | =75/250

A B C
1 Estimated painting cost per square foot
2 Total cost 575.00
3 Square Feet 250
4 Total/Sq Ft |=75/250]

E
B4 v J= | =75/250

il B C
1 Estimated painting cost per square foot
2 Total cost 575.00
3 Square Feet 250
4 Total/5q Ft sn.atru
5

TO CREATE FORMULAS THAT SPAN CELLS:

1.

Select the cell where the answer will appear (B4,
for example).

Type the Equal Sign (=).

Type the cell address that contains the first
number in your equation. Type the operator you
need for your numbers (+,-,/,* etc).

Type in the address of the cell that will be the last
number in your equation. Press enter. A blue line
will appear around the cells.

If you change a number in the sequence, your
new total will automatically be calculated.

B3 -

A B C D
1 Budget for June
2 |Budget for July
3 |Total Budget

4
SUM - x v f | =B1+B2
A B C O
1 |Budget for lune 5400.00
2 Budget for July 5 300.00
3 |Total Budget |=1+82] |
4
B3 - S | =B1+B2
f. B C D
1 Budget for June 5400.00
2 |Budget for July 5 300.00
3 Total Budget $TDO.DO"
4



